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This is a basic computer workshop. We will cover fundamental mouse and keyboard usage;
proper names for parts of the computer windows; file creation using save and save as; file
management including making folders and searching for files.
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Parts of the window
It’s important to know the vocabulary used for the different parts of the window.
Basic Applications
Notepad and Calculator are both applications that should come with every copy of Windows.
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1) Control Box – Many applications have a control box in the upper left corner of the window. This usually
looks like the icon of the program itself. In this case, a little notebook. When you click on this you get
several navigation options that let you move around the screen using the keyboard instead of the
mouse. It’s rarely used now, so some new programs won’t show one.
2) Title Bar – The title bar shows the file and the name of the application.
3) Minimize – Hides the window without closing the application. You can open it again by clicking on the
icon in the task bar.
4) Maximize – Makes the window take up the whole screen. When you
choose this option the button will change to “restore”.
5) Close – The X in the upper right corner is used to Exit the application.
6) Menus – The menus contain organized lists of operation you can do.
a. File – Open, Save, Exit
b. Edit – Copy, Search
c. Format – Change the text
d. View – Change the way the window looks
e. Help – Opens the help about this application
*NOTE* Notice the calculator doesn’t have a File or Format menu. This is
because there are no files to open or save, and no need to format the text.

Page 1

Other Applications
Adobe Acrobat Reader

1

This program has our
standard parts of the
window, with the addition
of two new sections.
1) Toolbar – This is usually
a grouping of visually
friendly buttons to help
you do common tasks.

2

2) Pane – This is a panel of
options that appears along
the side of the window.
Most panes can be easily
closed by clicking the X in
the corner of the pane, or
using the arrow along the
side to hide the pane.

Microsoft Paint
4

1

3
2
1) Ribbon/Tabs – The current versions of the Microsoft programs have taken away most of the menus and
replaced them with large toolbars. They are so large we can only see one set of buttons at a time, so
there are different tabs across the top of the window. The whole area is called a Ribbon, each page in
the ribbon is a Tab, each section of the tab is a Group. Above we are looking at the Home Tab. Here you
can see the Clipboard Group with our Copy and Paste Buttons.
2) Status Bar – Many applications have a status bar across the bottom of the window. This can tell you a
number of things about the file you’re working on. In this case it shows the size of the working area; in
Microsoft Word it would show the page number; in Outlook, how many emails are in the current folder.
3) Zoom – In the bottom left of this window we see the Zoom Slider. The Plus sign zooms in so you can see
more details, the Minus sign zooms out so you can see a broader overview.
4) Quick Access Toolbar – This toolbar is customizable; you can add your favorite buttons. Click on the
arrow at the end to see the most common options to add, or to see a listing of more button choices.
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Test yourself
Microsoft Word
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_____ Group (Editing)

_____ Ribbon

_____ Minimize, Maximize, Close

_____ Status Bar

_____ Pane (Navigation)

_____ Title Bar

_____ Quick Access Toolbar

_____ Zoom Slider

5 Group, 3 Min/Max/Close, 6 Pane, 1 Quick Access, 4 Ribbon, 7 Status Bar, 8 Zoom Slider
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File Menu Options
Here’s the File menu from Notepad. Notice the keyboard shortcuts are
listed next to the most common actions. The items with the ellipsis (…) will
open another window of options.
To use a shortcut key, hold down the first button, and while it’s down press
the second. The buttons don’t need to both be pressed at the same time.
The ones shown here are very common throughout Windows.
New – Makes a new file, where you can begin with a blank canvas
Open – Will open another window so you can find a saved file to work on
Save – Will replace the file you opened with the file you are working on
Save As – Will open another window to let you place the file where you want it, named however you want
Page Setup – Will open another window where you can set printing properties like margins and landscape
Print – Will open anther window where you can decide which printer to use, and which pages to print
Exit – Will exit/close the application. If you have not saved first, most programs will prompt you to do so.

Save vs. Save As
When you open a file you have three choices when it comes to saving.
1) Throw away all your changes. Close the file, or exit the application and choose not to save. Everything
you have done since the last time you saved will be gone.
2) Keep all your changes by saving the file. Most applications will remind you before you leave to save or
risk losing all your changes.
3) Keep the original, and keep the one you are working with your changes by use Save As.
I’m very visual, so I think about picking a piece of paper up from my desk. I make my changes, like writing notes
to myself on that paper.
If I chose option 1 it’s like everything I wrote on it since I picked the paper up has been erased, as if I never
picked it up.
If I chose option 2 it’s like I put the paper back on my desk and all my changes are still there.
If I chose option 3 it’s like I made a photocopy of the original and wrote all over the copy and put it on my desk.
This does leave me with two files. The original, and my new version. The save as option is nice because it keeps
the first version, but if I always save as I may end up with too many copies and forget which one to use. Just like
my real desk it’s easy to end up with a cluttered space. Luckily we can always clear off our “desk”
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Folders
A folder is a virtual location where we store our files and other folders. It’s an organization tool to help us keep
everything in, hopefully, a logical order. Again, just like real life piles of papers can be overwhelming, putting
them into folders helps keep us organized.
Creating a New Folder
First decide where you want the new folder to be and go to that location. Right‐click in an empty space to get
the shortcut menu. Click New, then click Folder.
If you’re in a folder you might even see a New Folder button.

The new folder will be created and it will be
ready for you to name it. Notice the text is
selected. Type in the name you would like to
use for the folder.
The computer does have a
few reserved characters,
that you cannot use in your
file and folder names. And
within the folder each item
has to have a unique name.
But ultimately, the computer doesn’t care what
you name your files and folders. Giving it a
name is for your benefit. Use something that
makes sense to *you*.
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Folder Window
To open the folder, you can double‐click on it, or right‐click and choose Open. Here’s some helpful information
from the Windows 7 help file:
1) Navigation pane ‐ Use the navigation pane to access
libraries, folders, saved searches, and even entire hard
disks. Use the Favorites section to open your most
commonly used folders and searches; use the Libraries
section to access your libraries. You can also use the
Computer folder to browse folders and subfolders.
2) Back and Forward buttons ‐ Use these buttons to
navigate to other folders or libraries you've already
opened without closing the current window. These
buttons work together with the address bar; after you
use the address bar to change folders, you can use the
Back button to return to the previous folder.
3) Toolbar ‐ Use the toolbar to perform common tasks,
such as changing the appearance of your files and
folders, or burning files to a CD. The toolbar's buttons
change to show only the tasks that are relevant. For
example, if you click a picture file, the toolbar shows
different buttons than if you clicked a music file.
4) Address bar ‐ Use the address bar to navigate to a
different folder or library or to go back to a previous one.
5) Library pane ‐ The library pane appears only when you are in a library (such as the Documents library). Use
the library pane to customize the library or to arrange the files by different properties. For more
information, see Working with libraries.
6) Column headings ‐ Use the column headings to change how the files in the file list are organized. For
example, you can click the left side of a column heading to change the order the files and folders are
displayed in, or you can click the right side to filter the files in different ways. (Note that column headings
are available only in Details view.)
7) File list ‐ This is where the contents of the current folder or library are displayed. If you type in the search
box to find a file, only the files that match your current view (including files in subfolders) will appear.
8) The search box ‐ Type a word or phrase in the search box to look for an item in the current folder or library.
The search begins as soon as you begin typing—so if you type "B," for example, all the files with names
starting with the letter B will appear in the file list.
9) Details pane ‐ Use the details pane to see the most common properties associated with the selected file. File
properties are information about a file, such as the author, the date you last changed the file, and any
descriptive tags you might have added to the file. For more information, see Add tags and other properties
to files.
10) Preview pane – (not shown, would be a pane on the right side of the window) Use the preview pane to see
the contents of most files. If you select an e mail message, text file, or picture, for example, you can see its
contents without opening it in a program. If you don't see the preview pane, click the Preview pane button
next to the help button in the toolbar to turn it on.

Page 6

Details View
As the Window’s help file says, the column headings are only available when you’re in the details view. Click on
the Change your view button in the toolbar to see the different view options.

When I’m working with pictures, I tend to use one of a large icon view. But for
almost everything else I prefer the Details view shown above. When you click on a
column title, Windows will sort by the column. I often sort by Date Modified to find
the files I most recently worked with from that folder. If you right‐click on a column
heading you’ll see a list of other possible headings to add, such as Date Created.
Extra Large Icons

Medium Icons

Large Icons

Small Icons

Tiles

List

Content
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Files
Files are created when we save. Whether it’s in a program, from the internet, or from an email.
File Types
Files are categorized based on the extension, the last few letters at the end of the file name. Your folders may be
set to not show the extensions, but the icons give a good idea of what kind of file you’re using.
Note: If you don’t see the extentions and you would like to, you can turn them on from the options. Open the
Tools menu, choose Folder Options, turn to the View tab, uncheck the box next to Hide extenions for
known file types.

Opening a File or Folder
The most common ways to open a file are to right‐click on the icon and choose Open from the shortcut menu, or
double‐click on the icon (the picture). The file type, the extension tells the computer which program to use for
you to work with this file.


Common picture files include PNG, JPG, BMP, and GIF files.



Simple text files might be TXT, or RTF.



The Microsoft programs each have different icons and extensions.
o

Word file extensions start with DOC

o

Excel file extensions start with XLS

o

PowerPoint file extensions start with PPT

Renaming a File or Folder
The most common ways to rename a file are to right‐click on the icon and choose rename
from the shortcut menu, or click once on the words, pause, click once on the words again.
Remember a double‐click will open the file, this is clicking twice, not double clicking.
The words of the file name will be highlighted. At this point you can start typing, and it will
replace the name. Press enter to accept and you’ll see your new file name.
*If* you had your file extension showing, those last few letters after the period at the end of
the name (see picture above), make sure to keep them. If you forget you can rename the file
again to include them.
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Deleting a File or Folder
Windows uses a recycling icon to hold the files you delete. You will usually have the icon on your desktop.
The most common ways to delete a file are to right‐click on the icon and choose Delete from the menu, or to
drag the object into the Recycling Bin. You will get a confirmation message asking if you really want to delete.

Undeleting a File or Folder
Immediately after you delete you can use the Undo option under the Edit menu. But if it’s been
awhile you may need to go to the Recycling Bin to get it back. You may need to close or minimize
your open windows to find the icon on the desktop.
Select the file or folder you want to undelete, and click the Restore this item button in the
toolbar. The object will disappear as it’s moved back into its original location.

The Recycling bin is a folder, so all folder options apply. If you set the view to details, as it is above, you can click
on the Date Deleted column heading to sort the contents.
You can permanently delete the contents by clicking on the Empty the Recycling Bin button on the toolbar, or
by right clicking on the icon on the desktop and choosing Empty Recycling Bin.
Searching for a File
Recent Files
If you have recently opened a file, the start menu
should have an option to show you a list to choose
from. Click on the Start button, and in the second
pane, choose Recent Files. If you see it on the list,
single‐click on it to open.
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Start Menu Search
The Start Button opens the Start Menu. The button is usually in the
bottom left of your computer screen, it should look like a flag. When you
open the Start Menu, you will see a Search for Programs and Files option
right above the Start Button.
Type all or part of the name of your file and press enter or click the search button, the magnifying glass. It may
take a few seconds for the computer to search for the file. If you see it on the list, single‐click on it to open.
If you don’t see the file, you will see a See more results above the search box. Click this option to open a search
window.
Search in a Folder
When you are in a folder, there should be a “search” option in the upper right corner. As you type in the letters
of your file name, you may see the matching words highlight for the files in this folder. .

A menu should appear under the text to let you Add a search filter by Date Modified
and by file Size.
If there are no results in this folder, you can choose a different location to look by choosing an option in the
Search Again In: section near the bottom of the window.

Save a Search
When you begin a search in a folder, your
move into a Search window. Notice the
address bar at the top of the window
above, “Search Results in …”
Click the Save Search button in the toolbar
if you would like to do this search again in
the future. Once you save the search it will
appear under the Favorites menu in the
left pane of the folder window.
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The rest of this handout comes from Microsoft Windows Help pages.
Using your Mouse
Just as you would use your hands to interact with objects in the physical world, you
can use
your mouse to interact with items on your computer screen. You can move objects,
open
them, change them, throw them away, and perform other actions, all by pointing and clicking with your mouse.
Basic parts
A mouse typically has two buttons: a primary button (usually the left button) and a secondary button (usually
the right button). The primary button is the one you will use most often. Most mice also include a scroll wheel
between the buttons to help you scroll through documents and web pages more easily. On some mice, the scroll
wheel can be pressed to act as a third button. Advanced mice might have additional buttons that can perform
other functions.
Holding and moving the mouse
Place your mouse beside your keyboard on a clean, smooth surface, such as a mouse pad. Hold the mouse
gently with your index finger resting on the primary button and your thumb resting on the side. To move the
mouse, slide it slowly in any direction. Don't twist it—keep the front of the mouse aimed away from you. As you
move the mouse, a pointer (see picture) on your screen moves in the same direction. If you run out of room to
move your mouse on your desk or mouse pad, just pick up the mouse and bring it back closer to you.
Pointing, clicking, and dragging
Pointing to an item on the screen means moving your mouse so the pointer appears to be touching the item.
When you point to something, a small box often appears that describes the item. For example, when you point
to the Recycle Bin on the desktop, a box appears with this information: "Contains the files and folders that you
have deleted."

Pointing to an object often reveals a descriptive message about it
The pointer can change depending on what you're pointing to. For
example, when you point to a link in your web browser, the
pointer changes from an arrow
.

to a hand with a pointing finger

Most mouse actions combine pointing with pressing one of the mouse buttons. There are four basic ways to use
your mouse buttons: clicking, double‐clicking, right‐clicking, and
dragging.
Clicking
Single‐clicking
To click an item, point to the item on the screen, and then press and
release the primary button (usually the left button).
Clicking is most often used to select (mark) an item or open a menu. This is sometimes called single‐clicking or
left‐clicking.
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Double‐clicking
To double‐click an item, point to the item on the screen, and then click twice quickly. If the two clicks are spaced
too far apart, they might be interpreted as two individual clicks rather than as one double‐click.
Double‐clicking is most often used to open items on your desktop. For example, you can start a program or open
a folder by double‐clicking its icon on the desktop.
Right‐clicking
To right‐click an item, point to the item on the screen, and then press and release the secondary button (usually
the right button).
Right‐clicking an item usually displays a list of things you can do with the item. For example, when you right‐click
the Recycle Bin on your desktop, Windows displays a menu allowing you to open it, empty it, delete it, or see its
properties. If you're ever unsure of what to do with something, right‐click it.
Dragging
You can move items around your screen by dragging them. To drag an object, point to the object on the screen,
press and hold the primary button, move the object to a new location, and then release the primary button.
Dragging (sometimes called dragging and dropping) is most often used to move files and folders to a different
location and to move windows and icons around on your screen.
Using the scroll wheel
If your mouse has a scroll wheel, you can use it to scroll through documents and web pages. To scroll down, roll
the wheel backward (toward you). To scroll up, roll the wheel forward (away from you).
Customizing your mouse
You can change your mouse settings to suit your personal preferences. For example, you can change how fast
your mouse pointer moves around the screen, or change the pointer's appearance. If you're left‐handed, you
can switch the primary button to be the right button. For more information, see Change mouse settings.
Tips for using your mouse safely
Holding and moving your mouse properly can help you avoid soreness or injury to your wrists, hands, and arms,
particularly if you use your computer for long periods of time. Here are some tips to help you avoid problems:
 Place your mouse at elbow level. Your upper arms should fall relaxed at your sides.
 Don't squeeze or grip your mouse tightly. Hold it lightly.
 Move the mouse by pivoting your arm at your elbow. Avoid bending your
wrist up, down, or to the sides.
 Use a light touch when clicking a mouse button.
 Keep your fingers relaxed. Don't allow them to hover just above the
buttons.
 When you don't need to use the mouse, don't hold it.
 Take short breaks from computer use every 15 to 20 minutes.
Using your Keyboard
Whether you're writing a letter or entering numerical data, your keyboard is the main way to enter information
into your computer. But did you know you can also use your keyboard to control your computer? Learning just a
few simple keyboard commands (instructions to your computer) can help you work more efficiently. This article
covers the basics of keyboard operation and gets you started with keyboard commands.
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How the keys are organized
The keys on your keyboard can be divided into several groups based on function:


Typing (alphanumeric) keys. These keys include the same letter, number, punctuation, and symbol keys
found on a traditional typewriter.



Control keys. These keys are used alone or in combination with other keys to perform certain actions.
The most frequently used control keys are CTRL, ALT, the Windows logo key
, and ESC.



Function keys. The function keys are used to perform specific tasks. They are labeled as F1, F2, F3, and
so on, up to F12. The functionality of these keys differs from program to program.



Navigation keys. These keys are used for moving around in documents or web pages and editing text.
They include the arrow keys, HOME, END, PAGE UP, PAGE DOWN, DELETE, and INSERT.



Numeric keypad. The numeric keypad is handy for entering numbers quickly. The keys are grouped
together in a block like a conventional calculator or adding machine.

Typing text
Whenever you need to type something in a program, e‐mail message, or text box, you'll see a blinking vertical
line ( ). That's the cursor, also called the insertion point. It shows where the text that you type will begin. You
can move the cursor by clicking in the desired location with the mouse, or by using the navigation keys (see the
"Using navigation keys" section of this article).
In addition to letters, numerals, punctuation marks, and symbols, the typing keys also include SHIFT, CAPS LOCK,
the TAB key, ENTER, the SPACEBAR, and BACKSPACE.
Key name

How to use it

SHIFT

Press SHIFT in combination with a letter to type an uppercase letter. Press SHIFT in
combination with another key to type the symbol shown on the upper part of that key.

CAPS LOCK

Press CAPS LOCK once to type all letters as uppercase. Press CAPS LOCK again to turn this
function off. Your keyboard may have a light indicating whether CAPS LOCK is on.

TAB

Press the TAB key to move the cursor several spaces forward. You can also press the TAB
key to move to the next text box on a form.

ENTER

Press ENTER to move the cursor to the beginning of the next line. In a dialog box, press
ENTER to select the highlighted button.

SPACEBAR

Press the SPACEBAR to move the cursor one space forward.
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Using keyboard shortcuts
Keyboard shortcuts are ways to perform actions by using your keyboard. They're called shortcuts because they
help you work faster. In fact, almost any action or command you can perform with a mouse can be performed
faster using one or more keys on your keyboard.
In Help topics, a plus sign (+) between two or more keys indicates that those keys should be pressed in
combination. For example, CTRL+A means to press and hold CTRL and then press A. CTRL+SHIFT+A means to
press and hold CTRL and SHIFT and then press A.
Find program shortcuts
You can do things in most programs by using the keyboard. To see
which commands have keyboard shortcuts, open a menu. The
shortcuts (if available) are shown next to the menu items.
Choose menus, commands, and options
You can open menus and choose commands and other options
using your keyboard. When you press ALT in a program with
menus, one letter in each of the menu names becomes underlined.
Press an underlined letter to open the corresponding menu. Press
the underlined letter in a menu item to choose that command.
This trick works in dialog boxes too. Whenever you see an underlined letter attached to an option in a dialog
box, it means you can press ALT plus that letter to choose that option.
Using navigation keys
The navigation keys allow you to move the cursor, move around in documents and web pages, and edit text. The
following table lists some common functions of these keys.
Press this

To do this

LEFT ARROW, RIGHT
ARROW, UP ARROW, or
DOWN ARROW

Move the cursor or selection one space or line in the direction of the arrow, or
scroll a webpage in the direction of the arrow

HOME

Move the cursor to the beginning of a line or move to the top of a webpage

END

Move the cursor to the end of a line or move to the bottom of a webpage

CTRL+HOME

Move to the top of a document

CTRL+END

Move to the bottom of a document

PAGE UP

Move the cursor or page up one screen

PAGE DOWN

Move the cursor or page down one screen

DELETE

Delete the character after the cursor, or the selected text; in Windows, delete the
selected item and move it to the Recycle Bin

INSERT

Turn Insert mode off or on. When Insert mode is on, text that you type is inserted
at the cursor. When Insert mode is off, text that you type replaces existing
characters.
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Using the numeric keypad
The numeric keypad arranges the numerals 0 through 9, the arithmetic
operators + (addition), ‐ (subtraction), * (multiplication), and / (division),
and the decimal point as they would appear on a calculator or adding
machine. These characters are duplicated elsewhere on the keyboard, of
course, but the keypad arrangement allows you to rapidly enter numerical
data or mathematical operations with one hand.
To use the numeric keypad to enter numbers, press NUM LOCK. Most
keyboards have a light that indicates whether NUM LOCK is on or off.
When NUM LOCK is off, the numeric keypad functions as a second set of
navigation keys (these functions are printed on the keys next to the
numerals or symbols).
Three odd keys
So far, we've discussed almost every key you're likely to use. But for the truly inquisitive, let's explore the three
most mysterious keys on the keyboard: PRINT SCREEN, SCROLL LOCK, and PAUSE/BREAK.
PRINT SCREEN (or PRT SCN) ‐ A long time ago, this key actually did what it says—it sent the current screen of
text to your printer. Nowadays, pressing PRINT SCREEN captures an image of your entire screen (a "screen
shot") and copies it to the Clipboard in your computer's memory. From there you can paste it (CTRL+V) into
Microsoft Paint or another program and, if you want, print it from that program.
Tip ‐ Press ALT+PRINT SCREEN to capture an image of just the active window, instead of the entire screen.
SCROLL LOCK (or SCR LK) ‐ In most programs, pressing SCROLL LOCK has no effect. In a few programs, pressing
SCROLL LOCK changes the behavior of the arrow keys and the PAGE UP and PAGE DOWN keys; pressing these
keys causes the document to scroll without changing the position of the cursor or selection. Your keyboard
might have a light indicating whether SCROLL LOCK is on.
PAUSE/BREAK ‐ This key is rarely used. In some older programs, pressing this key pauses the program or, in
combination with CTRL, stops it from running.
Other keys
Some modern keyboards come with "hot keys" or buttons that give you quick, one‐press access to programs,
files, or commands. Other models have volume controls, scroll wheels, zoom wheels, and other gadgets. For
details about these features, check the information that came with your keyboard or computer, or go to the
manufacturer's website.
Tips for using your keyboard safely
Using your keyboard properly can help avoid soreness or injury to your wrists, hands, and arms, particularly if
you use your computer for long periods of time. Here are some tips to help you avoid problems:
 Place your keyboard at elbow level. Your upper arms should be relaxed at your sides.
 Center your keyboard in front of you. If your keyboard has a numeric keypad, you can use the spacebar
as the centering point.
 Type with your hands and wrists floating above the keyboard, so that you can use your whole arm to
reach for distant keys instead of stretching your fingers.
 Avoid resting your palms or wrists on any type of surface while typing. If your keyboard has a palm rest,
use it only during breaks from typing.
 While typing, use a light touch and keep your wrists straight.
 When you're not typing, relax your arms and hands.
 Take short breaks from computer use every 15 to 20 minutes.
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Using buttons
A command button performs a command (makes something
happen) when you click it. You'll most often see them in
dialog boxes, which are small windows that contain options
for completing a task. For example, if you close a Paint picture
without saving it first, you might see a dialog box like this:
To close the picture, you must first click either the Yes or No
button. Clicking Yes saves the picture and any changes you've
made, and clicking No deletes the picture and discards any
changes you've made. Clicking Cancel dismisses the dialog box
and returns you to the program.
Pressing ENTER does the same thing as clicking a command button that is selected (outlined).
Outside of dialog boxes, command buttons vary in appearance, so it's sometimes difficult to know what's a
button and what isn't. For example, command buttons often appear as small icons (pictures) without any text or
rectangular frame. The picture below shows a variety of command buttons:

The most reliable way to determine if something is a command button is to rest your pointer on it. If it "lights
up" and becomes framed with a rectangle, you've discovered a button. Most buttons will also display some text
about their function when you point to them:

If a button changes into two parts when you point to it, you've discovered a split button. Clicking the main part
of the button performs a command, whereas clicking the arrow opens a menu
with more options.
Using option buttons
Option buttons allow you to make one choice among two or more options.
They frequently appear in dialog boxes. The picture below shows three option
buttons. The "Flip vertical" option is selected.
To select an option, click one of the buttons. Only one option can be selected.
Using check boxes
Check boxes allow you to select one or more independent options. Unlike option buttons, which restrict you to
one choice, check boxes allow you to choose multiple options at the same time.


Click an empty square to select or "turn on" that option. A check mark
will appear in the square, indicating that the option is selected.



To turn off an option, clear (remove) its check mark by clicking it.



Options that currently can't be selected or cleared are shown in gray.

Page 16

Using sliders
A slider lets you adjust a setting along a range of values.
A slider along the bar shows the currently selected value. In
the example shown above, the slider is positioned midway
between Slow and Fast, indicating a medium pointer speed.
To operate a slider, drag the slider toward the value that you
want.
Using text boxes
A text box allows you to type information, such as a search term or password. The picture below shows a dialog
box containing a text box. We've entered "bear" into the text box.

A blinking vertical line called the cursor indicates where text that you type will appear. In the example, you can
see the cursor after the "r" in "bear." You can easily move the cursor by clicking the new position. For example,
to add a word before "bear," you would first move the cursor by clicking before the "b."
If you don't see a cursor in the text box, it means the text box isn't ready for your input. Click the box first, and
then start typing.
Text boxes that require you to enter a password will usually hide your password as you type it, in case someone
else is looking at your screen.

Using drop‐down lists
Drop‐down lists are similar to menus. Instead of clicking a command, though, you
choose an option. When closed, a drop‐down list shows only the currently
selected option. The other available options are hidden until you click the control,
as shown here.
To open a drop‐down list, click it. Click the option choose it from the list.
Using list boxes
A list box displays a list of options that you can choose
from. Unlike a drop‐down list, some or all of the options
are visible without having to open the list.
To choose an option from the list, click it. If the option
you want isn't visible, use the scroll bar to scroll the list
up or down. If the list box has a text box above it, you
can type the name or value of the option instead.
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